Chapter 2

Creating Projects

Learning Objectives

After completing this chapter, you will be able to:
* Understand the Enterprise Project Structure

* Create a project

* Copy and delete a project

* Understand the Project Details Window
* Understand the OBS
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INTRODUCTION

Planning is the foremost important function of management. It is required at every stage of
management. Planning provides direction and facilitates decision making. It also reduces the risks
of uncertainty, overlapping and wasteful activities. The business activities will not be successful
in the absence of planning.

In this chapter, you will learn how to start planning and creating projects. Also, you will learn to
structure and add projects to the hierarchy. The process of setting up the EPS and OBS and to use
these methods for planning and managing project information is also explained in this chapter.

SETTING THE ENTERPRISE PROJECT STRUCTURE(EPS)

The EPS of an organization contains the hierarchical structure of all the projects in its database.
The hierarchial structure is designed to show various levels required to represent the work on
various projects in an organization. The EPS forms the initial grouping of the portfolios of the
projects. It helps in managing multiple projects from the individuals to the highest levels of
the organization. An organization has a large database that contains information about all the
current projects and other related things. For efficient management of the projects within an
organization the EPS should be structured in such a way that allows all the individuals to access
the concerned project data.

The EPS can be further sub-divided into many nodes or levels as required. The EPS nodes and
the procedure of adding the nodes are described next.

Understanding EPS Nodes

The EPS nodes represent the levels within the projects. The number of EPS nodes and their
structure depends upon the scope of the projects and on the method of reviewing the data. The
highest node in the EPS is the root node. The root node may have further divisions such as
zones, area construction, supervising team, and so on. Figure 2-1 shows an example of the EPS
and the EPS nodes in which the Innovative Construct node is the EPS which includes a lower
level EPS node called Facilities.
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Figure 2-1 The hierarchy showing nodes in an EPS

The Facilities node has three subnodes, namely Health Care, Education, and Commercial.
Each of these sub-nodes contains projects that are a part of the Facilities node. For example,
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the Health Care node contains the Lincoln Hospital Project Rehab Center and Harbour
Pointe Assisted Living Center sub-nodes. You can add as many projects required to complete
the desired work and which fall within the scope set by the operation executives and program
managers or engineers in the organization. Multiple levels in the EPS helps you to manage
projects separately while securing the data and summarizing it to the higher levels. For example,
you can outline the data information up to each node in the EPS and also top-down budgeting
can be checked from the top node to the lower node through their low-level projects for control.

Adding EPS Nodes

Menu Bar: Enterprise > Enterprise Project Structure

In Primavera P6, for assigning the EPS nodes to all the projects of an organization, choose the
Enterprise Project Structure option from the Enterprise menu in the menubar; the Enterprise
Project Structure (EPS) dialog box will be displayed, as shown in Figure 2-2. In this dialog box,
select the node under which you want to add a new EPS node. Then, choose the Add button
from the right pane of the dialog box; a new EPS subnode will be added under the selected
node. You can also assign a unique ID and name to the new subnode under the EPS ID and
EPS Name columns, respectively, refer to Figure 2-2.
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Figure 2-2 The Enterprise Project Structure (EPS) dialog box

In the Responsible Manager edit box, specify a responsible manager for the created [
node or choose the Browse button adjacent to it and select a different OBS element
for the node. You can use the arrow keys available in the right pane of the Enterprise
Project Structure (EPS) dialog box to indent/outdent a node to mark its placement v
in the EPS or to move a node up or down in the hierarchy.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com



Evaluation Copy. Do not reproduce. For information visit www.cadcim.com

2-4 Exploring Oracle Primavera P6 Professional 18

You can categorize many levels in the EPS hierarchy by including more than one root node.
To do so, add an EPS root node in the same way as you added an EPS node, but outdent the
root to the left most position in the hierarchy. Choose the Close button to exit the dialog box.
Select the Projects tool from the Enterprise menu in the menubar; the Projects window will
be displayed. In this window, the EPS will be displayed, as shown in Figure 2-3. The EPS nodes
that contain subnodes and projects are identified by a pyramid symbol. If there are more nodes
or projects rolled up beneath the selected subnodes then the EPS will be symbolized by an
additional symbol. Click on this symbol or double click on the node to display the additional
nodes or levels in the hierarchy.
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Figure 2-3 The Projects window displaying the EPS containing the EPS nodes and sub-nodes

You can open an EPS node to open all the projects in it or you can open the projects individually.
In the next section, you will learn to work with the project and also to add a project.

WORKING WITH PROJECTS

A project is a temporary group activity which is designed to perform different tasks and constitutes
a plan for creating a product or service. Being temporary, all the projects have a definitive start
and finish dates. A project can involve a single person, a single organizational unit, or multiple
organizational units.

An organization may have several projects to work on and each project has its own resource
assignments. Similarly, each prOJCCt has its own specific calendars, reports, and activity codes.
Working as a program manager in an organization, an individual has to manage one or more
higher level projects in the organization. Therefore, it would become convenient, if all such
projects are added under an EPS node.



Creating Projects 2-5

Adding a Project

To add a new project, open the Projects window by choosing the Projects tool from the Enterprise
menu in the menubar. In the Projects window, select the EPS node to which you want to add the
project and choose the Add button from the Command bar; the Create a New Project wizard
with the Select EPS page will be displayed, as shown in Figure 2-4.

Create a New Project ﬂ

Select EPS

Select the Enterprize Project Structure level for the new project.

Select EPS

(e £PS) =
@ cancel 4 P | Mext )| i Finish |

Figure 2-4 The Select EPS page of the Create a New Project wizard

In the Select EPS page of the Create a New Project wizard, the selected EPS name will be
displayed in the Select EPS edit box. You can change the existing EPS to the required EPS by
choosing the Browse button. On doing so, the Select EPS to add into dialog box will be displayed.
In this dialog box, select the EPS to be assigned and then choose the Select button from the
right pane of the dialog box; the Select EPS to add into dialog box will be closed and Iil
the selected EPS will be assigned to the project.

Now, choose the Next button; the Project Name page of the Create a New Project wizard will be
displayed, as shown in Figure 2-5. In this page, you can specify the id and name of the project
in the Project ID and Project Name edit boxes, respectively. Note that the project id is a short
and unique identifier of the project.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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Create a New Project H
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Figure 2-5 The Project Name page of the Create a New Project wizard

Once you have specified the project id and project name in the Project Name page, choose the
Next button; the Project Start and End Dates page of the Create a New Project wizard will be
displayed, as shown in Figure 2-6.

Create a New Project >

Project Start and End Dates

Specify the planned start date and must finish by date for the project.

The Must Finish By date is the date by which all project activities. mu{:&ﬂnish. If entered, it is used
as the project late finish date by the project scheduler.

Project Planned Start Must Finish By

2c o-c - =

@ cancel 4  Prev ‘ Next }‘ F  Finish |

Figure 2-6 The Project Start and End Dates page of the Create a New Project wizard

The Project Start and End Dates page of the wizard is used to specify the starting date and
desired ending date for the project. In the Project Planned Start edit box of this page, you can
specify the date on which you are planning to start your project. To specify a date, choose the
Browse button in the Planned Start edit box; the calendar to specify the date will be displayed.
Select a date from the calendar and then choose the Select button; the calendar will be closed
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and the date is specified in the Planned Start edit box. Similarly, in the Must Finish By edit
box, you can specify the date on which you want your project to get finished. Specify the Must
Finish By date to enable you to track the project delay.

After specifying the start and finish date in the Project Start and End Dates page, choose the
Next button; the Responsible Manager page of the Create a New Project wizard will be displayed.

In this page, you can assign a responsible manager to the project which is an OBS element and
is selected from the OBS structure. To specify the responsible manager, click on the Browse
button in the Responsible Manager edit box; the Select Responsible Manager dialog box will
be displayed, as shown in Figure 2-7. In this dialog box, select the OBS name from the list that
you want to assign as the responsible manager for your project. To do so, click on the desired
name and then choose the Select button displayed on the right side of the Select Iil
Responsible Manager dialog box.
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= .. ...

Figure 2-7 The Select Responsible
Manager dialog box

After specifying the responsible manager in the Responsible Manager page, choose the Next
button; the Assignment Rate Type page of the Create a New Project wizard will be displayed,
as shown in Figure 2-8.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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Figure 2-8 The Assignment Rate Type page of the Create a New Project wizard

The Assignment Rate Type page is used to specify the rate type you want to use to calculate
costs for the assignments in your project. To specify the rate type, choose the desired price
per unit from the Rate Type drop-down list. After specifying the rate type in the Assignment
Rate Type page, choose the Next button; the Congratulations page will be displayed with a
message that the project has been created as shown in Figure 2-9. Choose the Finish button in
the Congratulations page; the Create a New Project wizard will be closed and the new project
will be added under the selected EPS node.

Create a New Project E

Congratulations

“our new project has been created. To modify your project properties and define properties not
covered by this wizard, click on the Enterprize menu, and then click Projects.

4 prev ‘ Hext }‘ B Finish ‘

Figure 2-9 The Congratulations page of the Create a New Project wizard
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Defining the Project Status

The status of a project shows whether the project is completed or is still in progress. This will
help you to organize and summarize the information. If the project is a completed project then
it will be marked active and when it gets completed its status is changed to Inactive. You can
also assign a What-if status to a copied project.

To assign a status to a project choose the required project or the EPS node from the Projects
window; the details of the selected project will be displayed in difterent tabs of the Project
Details table. In the Project Details table, choose the General tab and select the desired status
for your project from the Status drop-down list, as shown in Figure 2-10. The Active status is
selected by default in this drop-down list.

Figure 2-10 Selecting the status from the Status drop-down in the General tab

If you want the status of the project other than the Active status then place the project under
separate root node in the EPS. Note that the project will still remain part of the hierarchy but
will not be considered as the part of that EPS when you budget, schedule, and level your active
projects. To place a project under separate root node, choose the Enterprise Project Structure
option from the Enterprise menu in the menubar; the Enterprise Project Structure (EPS) dialog
box will be displayed. In this dialog box, place the desired status root node at the bottom of the
EPS to keep it separated from the rest of the hierarchy. To designate the separated node as the
root node move the node to the left in the Projects window by using the Shift Left arrow button.

You can view projects with specific status. To do so, choose Filter By > Customize option from
the View menu; the Filters dialog box will be displayed, as shown in Figure 2-11. In the Filters
dialog box, select the desired check boxes corresponding to the desired status. Choose the OK
button; the projects with the specified status will be displayed in the Projects window.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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Figure 2-11 The Filters dialog box
Copying a Project

You can copy an existing node or project by using the template of that node or project. The
copied node or project then can be used as a template. When you copy a project in the EPS,
you can also copy the related links to the WBS documents, OBS, and other related elements. To
start with the copying process of a node or project, select the node or project you want to copy
and choose the Copy, Paste buttons from the Command bar; the Copy Project Options dialog
box will be displayed, as shown in Figure 2-12.

Copy Project Options

Optionally Include | & ok

W : @ cancel
[+ Issues and Thresholds
¥ Reports Help

¥ Documents
|+ Funding Sources
[~ Baselnes

[+ Summary Data

[~ Do not show this dialog again.

Figure 2-12 The Copy Project Options dialog
box
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To specify the attributes for your new project or node, select the required check boxes in the
Copy Project Options dialog box. Choose the OK button; the Copy WBS Options dialog box
will be displayed. In this dialog box, select the check boxes to select the attributes of the WBS
that you want to associate with your project, and then choose the OK button; the Copy Activity
Options dialog box will be displayed, as shown in Figure 2-13.

Copy Activity Options =
Specify the Activity information to be copied o oK
0 Cancel
[+ Resource & Role Assignments [ Expenses ¥ N
[v Relationships ¥ Activity Codes W Steps Help
¥ Only between copied activities [¥ WPs & Docs ¥ Financial Period Data

[~ Do not show this dialeg again.

Figure 2-13 The Copy Activity Options dialog box

Select the check boxes corresponding to the desired option(s) in the Copy Activity Options dialog
box and choose the OK button; the dialog box is closed and the EPS node or project will be
copied and added to the Projects window.

Deleting a Project

You can also delete an EPS node or project. To do so, select the EPS node or project to be deleted
and then choose the Delete button from the Command bar; the Primavera P6 Professional 18
message box with a warning will be displayed, as shown in Figure 2-14.

Primavera PG Professional 18

“You are about to DELETE project Office Building and
all its WBS elements, activities, etc. This action cannot
ke undone. Are you sure you want to continue?

Figure 2-14 The Primavera P6 message box displayed

This message box warns that if you delete this node or the project then all its related data which
include the WBS elements, activities, and so on will also get deleted and deleted cannot be
recovered. If you choose the Yes button in this message box, the selected EPS node or project
will be deleted.

' Note

@ When you delete an EPS node, all the projects under that branch of hierarchy will also be removed.
So, if you do not want to delete those projects, copy and paste them to some other area in the hierarchy
or under some other EPS node.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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Understanding Project Details Table
The Project Details table, as shown in Figure 2-15, is displayed under the Projects window. If
not displayed by default, choose View > Show on Bottom > Details from the menubar.

General \ Dates | Notebook | Budget Log | Spending Plan \ Budget Summary | Funding \ Codes \ Defaults | Resources | Settings. | Calculations \ Contract Manager |

EPS D

EPS Name

[Project Leads
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Responsible Manager
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Project Leveling Priority

[Active

Check Out Status
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Checked Out By

| [3-Medum

Date Checked Qut

| [

i

[checked n

=| |

Project Web Site URL

Figure 2-15 The Project Details table

The Project Details table contains various tabs having options to define an EPS or a project. You
can customize the details table by right clicking anywhere in the table; a menu will be displayed.
In this menu, select the Customize Project Details option; the Project Details dialog box will
be displayed. In this dialog box, you can shift the required options from the Available Tabs
list to the Display Tabs list. Some of the tabs and their options in the Project Details table are
discussed next.

General

The General tab helps you to view and edit general information such as ID, name, status,
responsible manager, risk level, project leveling priority for the selected node or project. If
applicable, you can enter the project web site address in the Project Web Site URL edit box.

Dates

The Dates tab helps you to edit time table information for the selected project or node. This
information includes the planned start date, must finish date, data date and finish date. Also,
you can specify the anticipated start and finish date for the selected project.

Notebook

The Notebook tab helps you in assigning notebook topics, details, and description to the selected
node or project.

Defaults

The Defaults tab enables you to specity the default settings or information for the selected project.
This information includes the default cost account for resource assignments to activities, default
automatic activity numbering, default activity calendar, duration type, and percent complete type.

Resources

The Resources tab helps you to specify resources essential for the project and project level
resource permission for the time sheet application. These permissions include allowing resources
to assign themselves to activities and to report their activities and assignments when completed.
The options in the Specify the default Rate Type for new assignments drop-down list of this
tab are used to calculate cost for activities that have labor/non-labor units with no assigned
resources/ roles and do not have prices.
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Settings

The Settings tab enables you to view and specify the summarized information and project-level
settings for the selected node or project. You can use the options in different fields of this tab
to summarize data for an EPS or a project and to automatically perform summary calculations
using summary services. This tab also includes the settings for the first month of the fiscal
calendar, the character for separating code fields for the WBS hierarchy, and also the settings
to define the critical activities.

Calculations

The Calculations tab enables you to calculate the cost and estimate usage of resources when the
activities in the selected project are updated. In this tab, the Resource Assignments area has
two radio buttons for keeping track of your budget. If you select the Add Actual to Remaining
radio button, then the amount will be at true complete units/costs. If you want to keep track
of the amount remaining before you exceed your budget, select the Subtract Actual from At
Completion radio button.

Select the Recalculate Actual Units and Cost when duration % complete changes check box
to automatically update the actual units and costs when the duration % complete is updated.
To recalculate units when costs are updated for resource assignments, select the Update units
when costs change on resource assignments check box. If you want to store past period actuals
in the Store Period Performance dialog box, then select the Link actual to date and actual this
period units and costs check box.

Note
You need to spectfy the details in other tabs also. Specify all necessary information about the project
in these tabs.

WORKING WITH THE OBS

The OBS, Organizational Breakdown Structure, is a hierarchical division of different project
responsibilities between different managers in an organization. The OBS reflects the management
structure of an organization from top-level personnel down, as shown in the Figure 2-16.

Before starting a project, you need to identify the tasks included in a project and the individuals
or team who will carry out those tasks. The OBS is an intermediate step in this process, it helps
in identifying the employees who will be responsible for the project work.

In Primavera P6, the OBS elements are associated with the EPS nodes and projects. Access and
privileges are assigned to the WBS/Projects/ EPS nodes through the OBS. Typically, an OBS is
set up with a project manager at the project level to oversee, coordinate and manage the entire
project. You can associate the responsible managers with their areas of the EPS in either nodes or
individual projects. A responsible manager associated to an EPS node by default gets associated
to the projects under the branch of the EPS.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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Figure 2-16 The flowchart displaying the hierarchy of a typical
organization setup

Note
In Primavera P6, an OBS can have only one root element.

Adding OBS
Menu Bar: Enterprise > OBS

To create, view, and edit an OBS in Primavera P6, invoke the Organizational Breakdown
Structure dialog box by choosing the OBS option from the Enterprise menu in the menubar. In
this dialog box, you can view a list of the OBS elements which can be used in any desired project.
You can display the OBS elements in two different ways, either by chart or table. Figure 2-17
shows the Organizational Breakdown Structure dialog box displaying the OBS in a tabular form.

You can create a new OBS by selecting the existing OBS element or node immediately above or
at the same hierarchy level. To add a new element, choose the Add button; the new OBS element
will be added under and at the same hierarchy level as of the selected OBS node.

You can specify all the information related to the created OBS by using the options available
in the General, Responsibility tabs of the Organizational Breakdown Structure dialog box.
These tabs are discussed next.
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Organizational Breakdown Structure

L.v.Display; Al OBS Elements
0OBS Name

=] B_\ Enterprise

B & |Company Head- Sham Tickoo

£ Project Manager
Site Engineer

Civil Foreman
", Labours
B Publishing Head
T Technical Manager
Authors
Eg\ Consultants Head
LB Enginesrs
B Esc
g_\ Energy

g_\ Manufacturing

X
i @ Close |
B A

o Add

x Del. / Merge
& cut

By  copy

B

General

Responsibility

0BS Name

|Cumpany Head- Sham Tickoo

0BS Description

B Modify | & Print | Bz Copy

<>

Figure 2-17 The Organizational Breakdown Structure dialog box

In the General tab, you can specify the name of the created OBS in the OBS Name edit box and
if required you can provide description of the OBS in the OBS Description edit box. The editing
tools displayed under the OBS Description edit box are used to format text, insert pictures,

copy, and paste information from other document files, and to add hyper links.

Users

In the Users tab, you can view the users and corresponding security profiles affiliated with
the OBS element. Also, if you have proper access rights then you can assign users to the OBS.

Responsibility
In this tab, the Project ID/WBS Code column lists the project ID/WBS code for which the selected
OBS element is responsible. The Project Name / WBS Name column lists the project name and

WBS name for which the selected OBS element is responsible.

You can also copy, paste, and delete an OBS. To do so, select the desired OBS element, choose
the Copy button; the desired OBS will be copied and then select the OBS to
which you want to add the copied OBS element and choose the Paste button.
The copied OBS element will be added to the desired OBS. Similarly, you can

cut and paste an OBS element.

You can also delete an OBS element. To do so, select the required OBS and choose
the Del. /Merge button from right pane of the Organizational Breakdown

Structure dialog box; the selected OBS element will be deleted.

Copy

E Paste

X Del. / Merge
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TUTORIALS
Tutorial 1 Creating EPS and OBS

In this tutorial, you will create EPS and OBS for a project. (Expected time: 30 min)

The following steps are required to complete this tutorial:

a. Open the Projects window.
b. Create EPS.

c. Assign OBS.

d.

Create a new project.

Opening the Projects Window
1. Open Primavera P6 and invoke the Projects window by choosing the Projects option from
the Enterprise menu in the menubar.

Creating EPS

1. Choose the Enterprise Project Structure option from the Enterprise menu in the menubar;
the Enterprise Project Structure (EPS) dialog box is displayed.

2. In the Enterprise Project Structure (EPS) dialog box, select the topmost EPS node under
which the new EPS element is to be added.

3. Next, choose the Add button from the right pane of the Enterprise Project Structure (EPS)
dialog box; a new EPS with the name NEWEPS is added to the topmost EPS node, as shown
in Figure 2-18.

Opening the Projects Window
1.  Open Primavera P6 and invoke the Projects window by choosing the Projects option from
the Enterprise menu in the menubar.

Creatmg EPS

Choose the Enterprise Project Structure option from the Enterprise menu in the menubar;
the Enterprise Project Structure (EPS) dialog box is displayed.

2. In the Enterprise Project Structure (EPS) dialog box, select the topmost EPS node under
which the new EPS element is to be added.

3. Next, choose the Add button from the right pane of the Enterprise Project Structure (EPS)
dialog box; a new EPS with the name NEWEPS is added to the topmost EPS node, as shown
in Figure 2-18.
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Figure 2-18 A new EPS added under the topmost EPS node in the Enterprise
Project Structure (EPS) dialog box

Click on NEWEPS in the EPS ID column and rename it to CADCIM. Change the name of
the EPS in the EPS Name column to CADCIM Technologies and press ENTER.

Ensure that the CADCIM EPS is selected and then choose the Shift Left button from the
Command bar; the CADCIM EPS node is now an independent node.

Next, choose the Shift Up button from the Command bar; the node is shifted on top, as
shown in Figure 2-19.

Ensure that the CADCIM EPS is selected and then choose the Add button; a new EPS node
is added under the CADCIM EPS.

Double-click on the NEWEPS node in the EPS ID column and change the ID of the created
EPS to Construction and EPS Name to Construction Division.

Similarly, add two more EPSs under the CADCIM head with the EPS ID as Publishing,
and Consultancy respectively and the EPS Name as Publishing Division, and Consultancy
Division respectively, refer to Figure 2-20.

Choose the Close button from the right pane of the dialog box to close the Enterprise
Project Structure (EPS) dialog box.
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Figure 2-19 The CADCIM EPS node displayed at the top
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Figure 2-20 The CADCIM EPS node with further subnodes displayed
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Creatmg OBS

Choose the OBS option from the Enterprise menu in the menubar; the Organizational
Breakdown Structure dialog box is displayed.

2. Select the Filter By > All OBS Elements option from the Display drop-down list; all the
OBS elements are displayed in the dialog box.

3. Inthis dialog box, select the topmost node and then select the Add button from the Command
bar, a new OBS with the name NEW OBS is created.

4. Choose the Shift Up button to shift the newly created OBS to the top.
5. Rename the created OBS as Company Head- Sham Tickoo in the OBS Name edit box.

6. Choose the Add button, a new OBS is created. Choose the Shift Right button to shift the
OBS to the right.

7. Add three more OBS under Company Head and ensure that all the added OBS are shifted
to the right.

8. Rename the added OBS as Project Manager, Publishing Head, and Consultants Head, as
shown in Figure 2-21.

Organizational Breakdown Structure X

v Display: All OBS Elements | B cose |
0BS Name

il

=B Inovative GC qr Add
B # |Company Head- Sham Tickoo

=8 Project Manager K Del/Merge

= Publishing Head .
3\ Consultants Head
B Esc = -
g Energy

g Manufacturing
£ prodDev
Tg\ ProdProg?
. ProdProg2

E-gEDrpDrate

B InFiight 12D
2\ Pipeline W

[

General Responsibility

0BS Name
ICDmDany Head- Sham Tickoo

0BS Description

<>

B Modify | & Prnt | Bz Copy |

Figure 2-21 Organizational Breakdown Structure displayed with the
structured OBS elements

9. Similarly, add more OBS in the order, as shown in Figure 2-22.
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10.

11.

12.

13.

14.

15.

Organizational Breakdown Structure »
* Display: All OBS Elements | B cose |
0OBS Name = A
=B Inovative GC qr Add

E-g\ Company Head- Sham Tickoo

B Project Manager 3 Del/Merge

g Site Engineer & cut
5_\ Civil Foreman

g Labours

B Publishing Head

g Technical Manager

% Authors

Consultants Head

“B Engineers

B EaC
B Energy Help

2_\ Manufacturing W

General Responsibility

0BS Name
[consuttants Head

0BS Description

<>

B Modify | & Prnt | Bz Copy

Figure 2-22 The Organizational Breakdown Structure is displayed with
the complete structured OBS

Next, choose the Close button; the Organizational Breakdown Structure dialog box is
closed and the Projects window is displayed.

Ensure that the Construction Division node is selected in the Projects window.

Now, choose the browse button adjacent to the Responsible Manager edit box in the General
tab of the Project Details table; the Select Responsible Manager dialog box is displayed.

In this dialog box, select the Company Head- Sham Tickoo node from the OBS Name list.

Choose the Select button from the Command bar; the responsible manager is assigned to
the construction division.

Similarly, assign Company Head-Sham Tickoo as the OBS to the Publishing and
Consultancy division node.

The EPS and OBS are created and are saved in the Primavera P6.




Creating Projects 2-21

Tutorial 2 Creating a Project
In this tutorial, you will create a project and will assign the OBS to the project. You must complete
tutorial 1 before performing this tutorial. (Expected time: 45 min)

The following steps are required to complete this tutorial:

a. Open the Projects window.
b. Create a Project
c. Export a Project.

Opening the Projects Window
1.  Open Primavera P6 and invoke the Projects window by choosing the Projects option from
the Enterprise menu in the menubar.

Creating a Project

1. In the Projects window, select the Construction EPS node from the CADCIM head. Choose
the Add button from the Command bar; the Create a New Project wizard with the Select
EPS page is displayed, as shown in the Figure 2-23.

Create a New Project “
Select EPS
Select the Enterprise Project Structure level for the new project.
Select EPS
|Cunstruc1inn Division| J
@ cancel Mext B | B Finish

Figure 2-23 The Create a New Project wizard with the Select
EPS page

2. In this Select EPS page, the Construction Division EPS is chosen by default. Keep the
default settings in this page and choose the Next button; the Project Name page of the

Create a New Project wizard is displayed.

3. Inthis page, specify CD00720 as the project id and Home Construction as the project name
in the Project ID and Project Name edit boxes, respectively.

4. Choose the Next button; the Project Start and End Dates page is displayed.
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5. In the Project Start and End Dates page, choose the browse button located adjacent to the
Project Planned Start edit box; a flyout calendar is displayed.

6. Using the flyout calendar, set the start date for the project to 29-Sep-18 and choose the
Select button from the flyout.

7. Choose the Next button; the Responsible Manager page is displayed, as shown in
Figure 2-24.

Create a New Project n

Responsible Manager

ldentify the responzible manager.

The responsible manager you select will be at the top of the organizational breakdown structure
(0BS) for the project.

Responsible Manager
ICDmpany Head- Sham Tickoo J

e Cancel ‘ Prev | Next }| E Finish |

Figure 2-24 The Responsible Manager page of the Create a New Project wizard

8. Choose the browse button adjacent to the Responsible Manager edit box of this page; the
Select Responsible Manager dialog box is displayed, as shown in Figure 2-25.

-« Display: All OBS Elements

Search I

OBS Name

B = Enterprize

L:'J-% Company Head- Sham Tickoo
% Project Manager
B Publishing Head
g\ Consuttants Head

B Eac

% Energy

B} Wanufacturing
=9 ProdDev

_% ProdProg1
B ProdProg2

Figure 2-25 The Select Responsible Manager
dialog box

9. If the elements are not displayed in this dialog box by default, select Filter By > All OBS
Elements option from the Display drop-down list.
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10. Select the Project Manager option in the OBS Name list and choose the Select button EI
from the right pane of the dialog box.

11. Choose the Next button in the Responsible Manager page of the Create a New Project
wizard; the Assignment Rate Type page is displayed.

12. Retain all the default settings in this page and choose the Next button; the Congratulations
page is displayed with the message that your new project has been created.

13. Choose the Finish button; the Create a New Project wizard is closed and the Home
Construction project is added to the Construction EPS, as shown in Figure 2-26.

Projects
Projects| Activities |

= Layout: Projects

Project Name Total Activities Strategic Priority

CADCIM Technologies
-2» Construction Construction Division o 500
= Choo720 Huome Construction 1] 500

<» Publishing  Publishing Division

<» Consultancy Consultancy Division

= 4 Enterprise All Initiatives

-» E&C Engineering & Construction
(o= ECO0S15 City Center Office Building Addition 71 100
(77 ECOD530 Mesbid Building Expansion 71 100
=] ECO0501 Haitang Corporate Park 71 100
[ =] ECO0E10 Harbour Painte Assisted Living Center 13 100
=] ECO0E20 Juniper Mursing Home 132 100
[ =] ECO0E30 Saratoga Senior Community 132 100

-1/» Energy Energy Services 683 500

Figure 2-26 The Home Construction project added under the CADCIM EPS

Similarly, create more projects for the Publishing and Consultancy Division, refer to
Figure 2-27.

Projects

Projects Activities

= Layout:Projects
Project IO

=+ [CADCIM

Project Name Total Activities Strategic Priority

CADCIM Technologies

-IZ» Construction Construction Division 0 500
"7 CDOo720 Home Construction 1] 500
-IZ» Publishing  Publishing Division 0 500
(7 CEOM Fievit Architecture 1] 500
(07 CaDoal AutoCal 1] 500
-I<» Consultancy Consultancy Division 0 500
[ CNOOF7O0 Banguet Hall Construction u] 500

Figure 2-27 All projects added under the CADCIM EPS

14. Repeat the procedure followed in step 1 through step 13 and assign 15 December, 2018 as
the start date and 31 July, 2018 as end date to the projects under the Publishing Division
node.
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16.

17.

For Consultancy Division project, enter 5th November, 2018 in the Project Planned Start
edit box.

In the General tab of the Projects page, choose the Browse button next to the Responsible
Manager edit box and assign Author as Responsible Manager for the Publishing Division

and Engineers for the Consultancy Division.

Primavera P6 automatically saves the created EPS and project.

Exporting Projects
Export projects to save the project file for future reference.

1.

To export the Home Construction project, ensure that the Home Construction project
is opened in Primavera P6. If not, then select the Home Construction project from the
Projects window and right-click; a menu is displayed. Choose the Open Project option from
the menu.

Now, choose the Export option from the File menu; the Export wizard with the Export
Format page is displayed.

In this page, ensure that the Primavera PM - (XER) radio button is selected and then choose
the Next button; the Export Type page is displayed.

In this page, ensure that the Project radio button is selected and then choose the Next
button; the Projects To Export page is displayed.

Make sure the Home Construction project is displayed in this page, as shown in Figure 2-28.
Choose the Next button; the File Name page is displayed.

Export H

Projects To Export

The projects listed below are open and can be exported.

Open Projects
Export Project ID Project Name

Home Construction

@ cancel 4 prev | Next }| B4 Finish |

Figure 2-28 The Home Construction project displayed in the Projects
To Export page
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6.

10.

11.

In this page, choose the Browse button adjacent to the File Name edit box; the Save File
dialog box is displayed, as shown in Figure 2-29.

Save File X
Savein: I PME j & &% -
* Mame - Date modified Type
o2 03-Oct-18 3:38 PM  File folder
Quick access
Desktop
m
Librarizs
This PC
Network
< >
File name: I j Save I
Saveastype:  |XER Fies ("xer) | Cancel |

Figure 2-29 The Save File dialog box

In this dialog box, browse to the C drive and then create a folder with the name PM6.

Open the folder PM6 and then create a sub-folder with the name ¢02. Next, open the created
folder and save the file with the name ¢02_CONS_Home_tut02 and then choose the Save
button.

Choose the Finish button; the Export Result page is displayed with the message that the
export was successful.

Choose the Close button; the file is exported.

Similarly, export other projects and save them at the same location with the name as
mentioned below.

AutoCAD- ¢02_PUB_CAD_tut02

Revit Architecture- ¢02_PUB_Archi_tut(2

Banquet Hall Construction- ¢02_CN_BNQT_tut02

Self-Evaluation Test

Answer the following questions and then compare them to those given at the end of this
chapter:

1.

In which of the following tabs of the Organizational Breakdown Structure dialog box, you
can specify the name and description of the OBS?

(a) General (b) Users
(c) Responsibility (d) none of the above
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2. In the Project Details table, which of the following tabs enables you to view and specify the
summarization information and project-level settings for the selected node or project?
(a) Resources (b) Notebook
(c) Settings (c) Calculations
3. In which page of the following pages of the Create a New Project wizard, you can specify
the project’s proposed start and finish dates?
(a) Select EPS (b) Responsible Manager
(c) Project Name (d) Project Start and End Dates
4. In the Project Details table, which of the following tabs enables you to specify resources
essential for the project?
(a) Notebook (b) Budget Log
(c) Codes (d) Resources
5. An EPS can further be sub-divided into many according to work in the organization.
6. The page of the Create a New Project wizard specifies the rate type you want to
use to calculate costs for the assignments in your project.
7. On choosing the Paste button from the Command bar, the dialog box is displayed.
8. The nodes in the EPS represent the levels within the projects. (1/F)
9. In Primavera P6, access and privileges to the WBS/Projects/ EPS nodes are assigned through
the OBS. (1/F)
10. The status of a project is shown by marking it Active if it is not completed and Inactive
when it gets completed. (1/F)
Review Questions

Answer the following questions:

1.

2.

In the Project Details window, which of the following tabs helps you in assigning notebook
topics, details, and description to the selected node or project?

(a) Calculations (b) Notebook
(c) Defaults (d) General

You can invoke the Organizational Breakdown Structure dialog box by choosing the OBS
option from the menu in the menubar.
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10.

In the page of the Create a New Project wizard, you can specify the EPS under
which you want to add the project.

To invoke the Enterprise Project Structure dialog box, choose the option from
the Enterprise menu in the menubar.

The EPS nodes that contains subnodes and projects are identified by a symbol.
You can use the button from the Command bar of the Enterprise Project
Structure (EPS) dialog box to indent/outdent a node to mark its placement in the EPS and

to move a node up and down in the hierarchy.

The Calculations tab enables you to calculate cost and estimate resources to be used when
you update activities in the selected project. (1/F)

You can add activities to your new project by using the methodologies available in
Methodology Management module of Primavera P6 by running the project architect. (1/F)

When you delete an EPS node, all the projects under that branch of hierarchy will also be
removed. (T/F)

You can use the template of an existing node or project to create a new one by copying the
existing node or project. (1/F)

EXERCISES
Exercise 1

Create an Enterprise Project Structure (EPS), as shown in Figure 2-30 and Figure 2-31 and
Organizational Breakdown Structure, as shown in Figure 2-32 for an enterprise of construction
department. Assume the name of the enterprise as ABC Technologies.  (Expected time: 30 min)
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Enterprise Project Structure (EPS) >
< Display: EPS | aE3 Close ‘
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- CONS Construction Divisi
< onstruction Division Jk -
- DIl & Gas il & Gas Plant Division
El<} Enterprise All Inttiatives % Copy
-l EEC Engineering & Construction
- Energy Energy Services B Lzl
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[l ProdDev Product Development 1 - >
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Figure 2-30 The Enterprise Project Structure (EPS) dialog box with the ABC EPS

mjects

ER BTE&S

FiliE YTE |&K 9

= Layout: Projects

Project ID Project Mame

Total Activities | Rizk Level Strategic

Priority

CADCIM Technologies

ABC Technologies

1T IT Division 0 3-Medum
< CONS Construction Division 0 3- Medum
2p Oil & Gas 0Oil & Gas Plant Division 0 3 - Medium

500
500
500

Figure 2-31 The EPS created in the Projects window
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: % Technical Manager - Construction
B CivilEngineers
. -G Ssite Formen
EIE Project Manager- Oil & Gas
. -BB Technical Manager - Oil & Gas
. -I@ 0il& Gas Experts

General Users Responsibility

Project ID / WBS Code

Project Name / WBS Name

I ABC Technologies
S T M- Division
< CONS Censtruction Division
< Oil & Gas 0il & Gas Plant Division

Organizational Breakdown Structure X
~ Display. All OBS Elements | @ Close |
0BS Name E i
l_r CEOQ of Company |:| O Add
EI% Technical Manager- T
% IT Engineers X DelfHerge
EIE Project Manager-CE % Cut

Figure 2-32 The OBS created for ABC Technologies project

Exercise 2

Create projects for the ABC Technologies under different EPS, as shown in Figure 2-33. You can
download project files related to these projects from the www.cadcim.com.
(Expected time: 45 min)

1. IT Division
a. Project]  Project Name
Project ID AADOO1

Project Start Date 22-Sep-18
Responsible Manager IT Engineers
Save File c02_IT_App_ex02
b. Project II Project Name Web Designer Java
Project ID WD002

Project Start Date 25-Aug-18
Responsible Manager IT Engineers
Save File c02_IT_WEB_ex02

2. Construction Division
Project Name  Hospital Building Project
Project ID CD00770
Project Start Date 05-Nov-18

Android Application Development

Responsible Manager Technical Manager - Construction

Save File c02_CONS_HOSP_ex02
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3. Oil & Gas Power Plant
a. Project]  Project Name XYZ Oilfield project
Project ID XYZ004
Project Start Date 15-Dec-18
Responsible Manager ‘Technical Manager- Oil & Gas
Save File c02_0&G_XYZ_ex02

b. Project II Project Name CSZ Gasfield project
Project ID CSZ005
Project Start Date 20-Oct-18
Responsible Manager Technical Manager- Oil & Gas
Save File c02_0&G_CSZ_ex02

Projects

R kT EB&

~ Layout: Projects
Project ID Project Name Total Activities | Rizk Level Strategic
Priority
ABC Technologies 0 3-hedium

Hp 1T IT- Division 0 3 - Medium 500
3 wDooz web Dezsigner Java 0 3 - Medium 500
3 Aaboot Android Application Designer 0 3 - Medium 500
= < CONS Construction Division 0 3 - Medium 00
[E3 CHOO770 Hoszpital Building Project 0 3 - Medium B00
= <» Oil & Gas Qil & Gas Plant Division 0 3 - Medium 500
(E3 C5Z005 C5Z Gasfield 0 3-Medium 500
E3 #2004 HrZ Oilfieid 0 3-Medium 500

Figure 2-33 The projects created in the Projects window

Answers to Self-Evaluation Test
1.a,2.¢,3.d,4.d, 5. nodes, 6. Assignment Rate Type, 7. Copy Project Options, 8. T,9.T,10. T



